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First steps

Welcome

Where to find more information and product support

Wel come to Microsoft Dynamics POS 2009 and t
The suggestions below can help you get started ringing up sales in no

time. Also, a wide variety of additional resources are available to assist

you in managing your store

Manager 6 s Gui de

Comprehensive and easy to use, thisMa n a g @uidédescribes the main features, capabilities,
and general use of Manager View, with pointers to additional information.

\Q If you are new to Microsoft Dynamics POS, get acquainted by looking through the
\ first two chapters, OFirst stepso6 and

Manager View Help

Find detailed information about Manager View in Manager View Help:

9 For information about the My Store view and the capsule reports that you see when you
first open Manager View, seedAbout My Store and capsule reports.0

9 For feature highlights of this release of Microsoft Dynamics POS, seed~eature highlights.6
For help using Manager View Help, seedMove around in Help.6

=a

9 For instructions for viewing the tutorials that acco mpany Microsoft Dynamics POS, see
d_earn to use Microsoft Dynamics PO

9 For information about product support options, see dProduct support.6
1 For answers to frequently asked questions, seedFrequently asked questionso

In many parts of Manager View, Help is context sensitive, providing detailed explanations of
the specific controls and options that you see on the screen.

1 On the Help menu, click Microsoft Dynamics POS Help
_Or-
Press F1.
_Or-

On the toolbar, click the Help button '@

Practice mode

Youcanuse practice mode to practice with Manager Vi
actual information.

\@5 Manager View Help u dJse practice moded

Getting Started

See the installation and setup guide, Getting Started for detailed information about installing
Microsoft Dynamics POS on the main computer and on additional computers.

Quick Reference card

Microsoft Dynamics POS includes aQuick Referencecard for cashiers. The card provides
keyboard shortcuts and step-by-step instructions for common POS View tasks.



Tutorial

"Setting Up POS Hardware" can assist you in connecting and setting up your pointof-sale
devices, such as a receipt printer and scaner.

1 Inthe CAProgram Filed Microsoft Dynamics - Point of Sale\en-US\Help\ folder, double -click
Hardware_Demo.exe .

Cashierodos Gui de

The Cashierds Guide provides an overview of the
Cashierf6s Gui deanleiread of &feenforgrintad foreasy reference.

\@5 If you are new to Microsoft Dynamics POS, get acquainted by looking through the

first two chapters, OFirst stepso6 and

Microsoft Certified Partners

You can also take advantage of an ongoing relationship with a Microsoft Certified Partner who

understands the unique service needs of your business.

‘@ To find a partner near you, visit the Microsoft Dynamics POS Web site at
http://www.microsoft.com/pos .

On the Web

You can find information about Microsoft Dynamics POS 2009 at the Microsoft Dynamics Web
site, including product information, updates, tips for retailers, demos, customer stories, and
additional training.

‘Q http: //www.microsoft.com/pos

Community

The active newsgroup community is a great way to share information and learn from other
retailers using Microsoft Dynamics POS.

‘@ Microsoft Dynamics POS Newsgroup

Microsoft product support

Business Ready Enhancement Plan

Your Microsoft Dynamics POS Business Ready Enhancement Plan provides a number of
exciting benefits:

Version upgrades and product updates

Service packs and hot fixes

Access to CustomerSource and the Microsoft Knowledge Base

Unlimited online training

Lifecycle support (seehttp://support.microsoft.com/lifecycle)

=A =4 =4 4 —a =2

Protected list price
The phone number for the support line is 1-888-477-7877.

lj@ For more information, contact your Microsoft Certified Partner or see
http://www.microsoft.com/dynamics/support



http://www.microsoft.com/pos
http://www.microsoft.com/pos
http://www.microsoft.com/Businesssolutions/Community/Newsgroups/dgbrowser/en-us/default.mspx?dg=microsoft.public.pos&lang=en&cr=US
http://www.microsoft.com/dynamics/support

Microsoft Services Premier Support
Microsoft Services Premier Support is also available.

I‘@ For more information, see
http://www.microsoft.com/services/MicrosoftServices/srv_premier.aspx .

Professional Paid per Incident Support
Finally, you can obtain Professional Paid per Incident support.

|j@ For more information, see http://support.microsoft.com/?LN=en -us&scid=gp;en-
us;offerprophone&x=9&y=13 .

Microsoft CustomerSource

CustomerSource is a Microsoft Web site that provides Microsoft customers around-the-clock
access to support resources and a multitude of tools to improve their business processes and
practices.
\@ Information (and site access for Microsoft customers currently on a service plan)

is available athttp://www.microsoft.com/dynamics/customersource.mspx .

Product information

[ For product information about Microsoft Dynamics POS and other Microsoft
retail, business, and accounting software, visit the Microsoft Dynamics Web site
at http://www.microsoft.com/dynamics/defa ult.mspx .
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First steps

What 6s new

Many new features in Microsoft Dynamics POS

Microsoft Dynamics POS offers a wide range of features and powerful
tools for managing your business with efficiency and creativity. Here are
some highlights

Layaways, quotes, and work orders

In addition to sales and returns, you can now process layaways, quotesand work orders, and
generate reports specifically for these transaction types. To start a new layaway, quote, or work
order, select from the new dropdown on the POS View screen

Back orders and special orders

When an item is out-of-stock, cashiers now hawe the option to put the item on back order or
special order.

Vouchers

Microsoft Dynamics POS now offers vouchers, a payment method that can be used for gift
cards, store credit, or other custom payment options.

Kits
A kit is a bundle of items that are sold together as a single item, such as a firstaid kit or a gift

basket. The items within a kit are known as component items. A kit is built from available stock
of the component items and can be broken out into its component items if needed .

Inventory locations

An inventory location can be an actual physical location (such as Back Room, Warehouse, or
Under the Stairs), or it can be a conceptual grouping of items (such as Damaged Reserved, or
Not Yet Shelved).

Price-embedded barcodes

A price-embedded bar code is a bar code that contains both an item number and a price.

These bar codes are typically used on items that are weighed or measured. The bar code labels
can be printed and applied to items by a packager or supplier, or right in the store, such as

with a scale that is used to weigh deli items.

Offline mode

With offline mode, you can continue to ring up sales and perform other register tasks even if
the connection to the main store database is not available.

Charge accounts

Set up charge accounts so customers can charge their purchases and make payments, with the
store collecting interest amounts that might otherwise go to a credit -card company.

Employee roles

Add security to the store by creating roles for employees and assigning permissions, feature by
feature.



Matrix items

Group, sell, and order related itemsii such as different sizes, colors, and styles for apparel
itemsi by using matrix items.

Supplier lots

By adding supplier lots to items, you can order using one size package and sell using anotter.

New reports
In addition to the reports included with previous releases, take advantage of new reports.

i@ More information

=

=A =4 =4 =4 =4 4 -8 -8 A

Manager View Help u
Manager View Help u

Manager View Help
vouchersd

Manager View Help
Manager View Help
Manager View Help
Manager View Help
Manager View Help
Manager View Help
Manager View Help
Manager View Help
Manager View Help

c

CcC Cc CcCcCcCc cCc cCc C

What 0% new
cust omer

0OAbout

order so

QAbout gift cards, gift certificates, and store credit

QAbout kits 6

OAbout inventory locations 6
QAbout price-embedded bar codeso

OAbout offline mode 6

OAbout charge accountsé
QAbout roles and role settings6

OAbout matrix items and style numberso

OAbout supplier lots 6
OQAbout reports 6



First steps

Start and exit Microsoft Dynamics POS

Get started quickly

Before you can start Microsoft Dynamics POS, your name, employee ID,
and password must have been set up in th e Store Setu p Wizard or in
Manager View

Start Microsoft Dynamics POS

1 On the Start menu, pointto Programs or All Programs , point to Microsoft Dynamics
POS and then click Microsoft Dynamics POS .

2 Inthe Logon dialog box, type your employee ID and password.

Tip

-

If you are logging on using a touch -screen, press thetouch-screen keyboard button to display
the touch-screen keyboard

Microsoft Dynamics POS starts in POS View.

Start Microsoft Dynamics POS as an administrator

I On the Start menu, point to Programs or All Programs , click Microsoft Dynamics POS
2009 , right-click Microsoft Dynamics POS , and then click Run as administrator

Exit Manager View and Microsoft Dynamics POS
1 On the File menu, click Exit (ALT+F4).

_Or-
9 Click the Exit button on the left side of Manager View.

Note

Depending on your employee role settings, you might not be able to exit Microsoft Dynamics
POS

Switch between POS View and Manager View

Switch to Manager View
1 PressF7 (Tools), and then press8 (Manager View).
_or-

Start and exit Microsoft Dynamics POS 6



-

1 Click the Manager View tab.

=2l Microscft Dynamics POS (Be

| Enter a number, nar

Common Tas

Note

Depending on your employee role settings, you might not be able to switch to Manager View .

Switch to POS View
9 Click the POS View tab.
_or-

1 In Manager View, click POS View on the View menu.

POS View and Manager View

Microsoft Dynamics POS 2009 consists of two views:

1 POS Viewis the point-of-sale screen cashiers use to process transactions and returns, look
up items and customer information, receive inventory, and do other daily register tasks.

1 Manager View is a convenient and central location managing inventory and store
information; for example, creating reports and purchase orders, receiving inventory, and
managing customer and employee information.

I@ More information
1 ManagerViewHelpu 0 St art Microsoft Dynamics
1 Manager ViewHelpu 0 Acti vate Microsoft Dynami
1 POSViewHelpu 0 Switch between POS View and

Start and exit Microsoft Dynamics POS 7
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First steps

Introducing Manager View

Get acquainted with its main parts and practice using Manager View

T8 Microsoft Dynamics POS 2009 [E=IET=S)
File Edit View Inventor cople Reports  Tools Transactions ~ Settings  Help
Bl || @New +|[[IDuplicate | 4 WP & X |#Find | @
I
My Store 2 ltems Current View: Active ~
T || = 3 vy store +||1tem Type | item Num... | Style N... | ipti |Avail... - |OnOrder |Price |LastOrd...|Last Up... |~
[y 3 customers + Add a new ite
@ |33 Employees Standard 3002004 Green Tea - Box 47.000 0.000 $10.99 6/2/2008... 6/12/2008
a9 Tnventory, Standard 3002005 Flavored Black Tea - Box 47.000 0.000 $7.99 6/2/2008... 6/11/2008
= ga‘eg::es‘s Standard 3002008 Jasmine Tea - Box 47.000 0000 $15.39 6/2/2008.. 6/10/2008
- epartment
8D Dierions Standard 2003012 Chocolate Milk. 48.000 0.000 $1.00 6/2/2008... 6/5/2008
9 Discounts -Ttem Standard 3002006 Herbal Tea Assortment - 48.000 0.000 $7.99 6/2/2008...6/5/2008...
) Discounts -Preset Standard 3002007 Darjesling Tea - Box 48.000 0.000 $12.99 6/2/2008... 6/5/2008
£ Inventory Locations Standard 3001001 3001 BreakfastBlendﬂ 48.000 0.000 $9.99 6/2/2008... 6/5/2008...
3 Inventory Transfers | _ ||| Standard 3001003 3001 Light Roast - Re 48.000 0.000 $9.99 6/2/2008... 6/5/2008...
% Item Messages Standard 3001004 3001 Dark Roast - Reg 48.000 0.000 $9.99 6/2/2008... 6/5/2008...
W 150 Recepts Standard 3001008 3001 Kenya - Reg 48.000 0.000 $9.99 6/2/2008... 6/5/2008...
R4 ::'"s Standard 3001009 3001 Mocca Java - Reg 48.000 0.000 $9.99 6/2/2008... 6/5/2008...
‘5? ysical Inventories Standard 2003005 Apple Juice 49.000 0.000 $150 6/2/2008... 6/10/2008... .=
] purchase Orders Standard 2003006 wat 50.000 0.000 $1.00 6/2/2008
& sopplers andar ater X X K
= [ Reports -
\? Customer Item number: 3002006 Status:
(23 Inventory =
(L3 Miscellaneous L4 Bar code: 3002006 "|  Hemtype:
(23 Orders s TR =
. Herbal Tea Assortment - Box :
3 Seles Description: Department:
) m *Pgo i Extended description: e ~ | Category: Tea (300-2)
i 1y store Sales tax: Sales Tax (Re
;}\ @ Pr—— ~| Price:
& Inventory Detail line 1: i | Cost:
0 s Detail line 2: Profit margin:
. Detail line 3: Available:
ot “ﬁ_f%! Store Settings |
Pichirs: I Rin In~atinn: &
g Transactions < i ] )
Logged In: Oliver Cox | 197 ltems 6 Monday, December 15, 2008 10:28 AM _;

If Manager Vi ew on your computer doesMaddagerl ook

View pictured her Syme gartad t Managear rView might
have been customized to work the way your store do es.

o View tabs

Click a tab to display either POS View or Manager View

e Menus and toolbar

The menus provide access to all store information and to tools and wizards that help you
manage that information and run your store.

The toolbar is most useful when there's a list of information in the content pane (such as the
Items list shown above). For example, with one clickyou can create and delete records in the
current list.

9 Content pane

In the content pane, you can view task centers lists of the inform ation in your store database,
or view My Store to get an overview of the activity in your store.

1 To view a task center, click the folder ornavigation button for the task center you want.

1 Toview a list, clicka task center button, menu command, or subfolder for the list you want.
1 Toview My Store, click My Store in the navigation pane.

The picture on the previous page shows the Items list, a complete list of your items, where you
can create, modify, or delete items.

Introducing Manager View 8
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o Navigation pane
The tree in the navigation pane provides an overview of your store information, in a familiar
and easy-to-use folder arrangement.

Use the large buttons at the bottom o f the pane to view your most commonly used
information with a click of the mouse .

o Preview pane

When a list view is showing in the content pane, you can preview a record by selecting it in the
list. The preview pane shows general information about the selected record.

e Tray

The tray contains buttons for the Help and Exit commands.

The disabled (gray) buttons are only available in POS View. There, you can use these buttons to
switch users and turn the function bar and touch-screen keyboard on and off

o Status bar

Displays status information, such as the date and time

Practice using Manager View

You can safely practice usingManagerVi ew at any time without affect
valuable information.

Simply enter practice modeand create or modify customers, employees, purchase orders, or
make any other changes and the store database will not be affected.
Note

In POS View, he sales you ring up in practice mode will not be kept, the cash drawer will not
open, and credit card, debit card, and check transactions will not be processed.

Before you can use practice mode,follow the steps below to set practice mode up .

Set up practice mode

1l start Microsoft Dynamics POS as an administratoc
POS. ¢6)

2 Onthe Tools menu, click Practice Mode Setup .

Enter practice mode
Y On the Tools menu, click Practice Mode .

Microsoft Dynamics POS displaysaredvat er mar k t hat r emthe OPractic
content pane to indicate that you are in practice mode.

Exit practice mode
9 On the Tools menu, click Exit Practice Mode .

|@ More information

1 Manager ViewHelp u dGetting started6
1 Manager View Help u d_earn to use Manager Viewd
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Basic settings

Road map: Quickly set up your store

A direct route to productivity and sales
Install and start Microsoft Dynamics POS
Getting Started Wizard
Create Database Wizard
Offline Mode Wizard
Store Setup Wizard — Store Settings
Create Password Wizard
Store Setup Wizard — Main Menu

Activation Wizard

Ready to ring up sales

The first time you start Microsoft Dynamics POS, a series of short
wizards walk you through specifying initial settings. You can then begin
ringing up sales right away , while specifying m ore detailed settings  later

as time permits.

Install and start Microsoft Dynamics POS
See the Getting Started:Installation Guide for complete instructions.

You can start the program automatically at the end of the Installation Wizard. Otherwise, click
the Windows Start menu, click All Programs , and then click Microsoft Dynamics POS .
Getting Started Wizard

In this required wizard, you:

9 Agree or disagree to the terms of license agreement.

1 Specify whether you want to create a database orconnect to one you already have.

9 Indicate whether or not you want to participate in the Customer Experience Improvement
Program.

Create Database Wizard

If you chose to create a new database,Microsoft Dynamics POS displaysthe Create Database
Wizard to help you create an initial store database.

You can create a blank database or you can start with one of two sample databases included
with Microsoft Dynamics POS; one for a fictitious toy store and the other, for a fictitious coffee
shop.

Each sample databasencludes inventory, employees, customers, task pads, extensive settings,
and examples of various features as they would be set up in typical stores.

Offline Mode Wizard

This required wizard can helpyou set up offline mode, which you can use to keep your store
operational during network downtime.

Roadmap: Quickly set up your store 1 1



Store Setup Wizard i Store Settings

If you chose to create a new database, he Store Setup Wizard helps you specify a few
important settings, such as sales tax and payment methods.

Create Password Wizard

If you chose to create one of the sample databases,Microsoft Dynamics POS displaysthe
Create Password Wizard to helpyou create temporary passwords for the sample employees in
the database.

Store Setup Wizard 1 Checklist

From the Store Setup Wizard €hecklist, the wizard can help you set initial settings for basic
store information, employees, importing existing items or customers, creating departments and
categories, and sharing information with accounting programs.

Activation Wizard

In this required step, use the Activation Wizard to activate Microsoft Dynamics POS You must
activate the program to be able to use it.

Activation reduces software piracy by authenticating your software as a genuine, fully licensed
copy. Each copy of Microsoft Dynamics POS can onj be activated on a single computer, so you
will need a separate copy of the software for each computer where you want to use Microsoft
Dynamics POS

The one exception to the activation requirement is this: you can install and use Microsoft
Dynamics POS ona back-office computer without activating, if the computer will not be used
to process transactions. Whenasked if you want to open in Manager View without activating,
click Yes. After that, Microsoft Dynamics POS will always open in Manager View; you wil not be
able to switch to POS View unless you activate the software from the Help menu

Checklist for quick store setup

Use this checklist to make sure you have specified the minimum store settings to start ringing
up sales.You can specify most ofthe basic settings in the Store Setup Wizard.

C Owner information
Basic store information
Employees

Payment methods

Sales taxes

O O O 0O 0

Registers and hardware

Install Microsoft Dynamics POS, specify register settings, and st up POShardware on each
register in a multiple -computer store.

Items

Cashiers can add items as they are sold to inventory at the registers. Or you can import an
existing item list.

0

':0 More information

1 Manager View Help u d&Set up your storeo
1 Manager View Help u dmport information into the store database6



Basic settings

Checklist: Complete store setup

A comprehensive plan for store productivity

You can use this comprehensive checklist to make sure you are taking full
advantage of all the powerful features in Microsoft Dynamics POS . Set up
your store information in the order shown, since setting up some features
depend s on others.

G
G

O 0 0 0 0O O 0

O 0 0 O

Specify owner information
Specify this in the Store Setup Wizard.

Specify store information
On the Settings menu, point to Store Settings , and then click Store Information

Set store options, policies, and procedures
On the Settings menu, point to Store Settings , and then click Options .

Create task pads
On the Settings menu, point to Register Settings , and then click Task Pads.

Create employee roles
On the Settings menu, point to Store Settings , and then click Roles.

Create employees
On the People menu, click Employees .

Create or customize receipt formats
On the Settings menu, point to Register Settings , and then click Receipt Formats .

Create line display messages

On the Settings menu, point to Register Settings , and then click Line Display
Messages.

Set up registers and hardware

Install Microsoft Dynamics POS, specify register settings, and set up POS hardwaren each
register in a multiple -computer store.

Set up sharing information with accounting

On the Settings menu, click Configure QuickBooks

Set up currencies
On the Settings menu, point to Store Settings , and then click Currencies .

Create payment methods
On the Settings menu, point to Store Settings , and then click Payment Methods .

Set up payment processing

On the Settings menu, point to Store Settings , click Options , and then click the
Payment tab.

Set up destination-based taxes

On the Settings menu, point to Store Settings , click Options , and then on the Sales Tax
tab, select the Use destination - based taxes check box.

Specify tax authorities

On the Settings menu, point to Store Settings , and then click Tax Authorities

Set up tax locations
On the Settings menu, point to Store Settings , and then click Tax Locations .

Checklist: Complete store setup 13



C Setup sales taxes
On the Settings menu, point to Store Settings , and then click Sales Taxes.

C Setthe default sales tax

On the Settings menu, point to Store Settings , click Options , and then click the Sales
Tax tab.

Create departments and categories

On the Inventory menu, click Tax Locations or Categories .

Create suppliers
On the Inventory menu, click Suppliers .

Create inventory locations
On the Inventory menu, click Inventory Locations .

Specify item and preset discounts
On the Inventory menu, click Discounts .

Create item messages
On the Inventory menu, click ltem Messages .

Add pictures of items to File Center
On the Tools menu, click File Center .

Create items
On the Inventory menu, click ltems . Or on the File menu, click Import Wizard .

Assign items to departments and categories
On the Inventory menu, click ltems .

Select sales taxes for items
On the Inventory menu, click ltems .

Select item messages for items
On the Inventory menu, click ltems .

Select item discounts
On the Inventory menu, click ltems .

Select pictures for items
On the Inventory menu, click ltems .

Add pictures of customers to File Center
On the Tools menu, click File Center .

O O 0 O O O O O O 0 0 O 0O 0

Set up custom fields for customer information

On the Settings menu, point to Store Settings , click Options , and then click the
Customer tab.

Create customers

On the People menu, click Customers .

0

I‘.@ More information

1 Manager View Help u dSet up your storeo
1 Manager View Help u dmport information into the store database 6

Checklist: Complete store setup 14



Basic settings

Set up inventory

Useavarietyof ways to set up your storeads

Use the Import Wizard to bring existing inventory information into
Microsoft Dynamics POS. You can also add items to inventory as you
receive them, or at the register as they are sold, or you can modify one

of the included sample databases .

Use the Import Wizard

You can wse the Import Wizard to bring your existing inventory information into Microsoft
Dynamics POS. You can import items, customers, suppliers, and inventory counts. You can
create new records in the database or update existing ones. Import inventory in three steps:

1 Prepare the import file in the other program

Use the source program (such as Microsoft Office Excel) to prepare the import file so itis in a
format the Import Wizard can read. Make sure it contains:

9 All of the information you want to import

1 All of the information the wizard needs to create or update the records in the store
database

The more complete and accurate the import file is, the easier importing will be.

2 Save or export the import file as a text file
Use the source program (such as Microsoft Office Excel) to save or export the information into
a text file. A text file typically has a .txt or .csv file extension.

If needed, you can make changes directly to the text file that will make the import more
efficient. For example, you can remove any stray quotation marks that might have been added
to the file when it was created, and you can add text qualifier characters where needed.

3 Start the Import Wizard
1 On the File menu in Manager View, clicklmport Wizard .

In the Import Wizard, specify the type of information you want to import, the name of the
import file, and whether you want to update existing database records using the information in
the file. Then enter information about how t he import file is organized.

For example, you will need to indicate whether the columns of inform ation in the file are
delimited (separated by characters such as tabs or commas and if so, what character is usedyr
fixed width (meaning a certain consistent number of characters wide).

Tip

1 For best results, do a bit of research before you import. Become familiar with the type of
information the Import Wizard requires, and make sure your import file is set up correctly.

1 Consider doing a test run in the wizard to see the options that are available. To avoid
actually importing your test file into your database, be sure to click Cancel on the Preview
page of the wizard.

1 You can save the settings you enter in the Import Wizard for use in later imports.

Add items to inventory as you receive them

A common practice in many retail storesis adding items to inventory as they are received. You
can do this easily in either Manager View or POS View, with or without an associated purchase
order. Using a scanner ard having other information about the item s at hand, such as their
prices, can speed the process



Add items to inventory as they are sold

You can add items to inventory in POS View as th
in the store database, Microsoft Dynamics POS asks if you want to add it.

Modify a sample database

Microsoft Dynamics POS comes with two sample databasesone for a coffee shop and one for
a toy store.

Each sample database includedictitious items, customers, suppliers, and otrer information and
settings that can modify or view to help you get started setting up your own store.

l@ More information

Manager ViewHelpu o0l mport i nformation into the
Manager ViewHelpu 0 About managing your inventor
Import Wizard Help u Click Help on any page in the wizard.

POS View Helpu @Add an item to inventory 6
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Basic settings

Customize Manager View

Set up Manager View to work the way you do

You can customize Manager View to suit your needs. Select the screen
elements and features that are useful to you, and display the information
that you want

Show or hide screen elements

Show or hide the navigation pane
1 On the View menu, click Navigation Pane .

Show or hide the toolbar
T On the View menu, click Toolbar .

Show or hide the preview pane
T On the View menu, click Preview Pane.

Show or hide the status bar
 On the View menu, click Status Bar .

Arrange columns and panes

Arrange the columns of a list
9 Drag the column header to its new location.

Change the sort order of a list
9 Click a column header.

Change the layout of capsule reports
1 Onthe View menu, point to Content Pane , and then click the layout that you want to use.

Size a column in the content pane
9 Drag the border of a column header.

Size a pane
9 Drag the border of a pane.

Change between small and large toolbar icons
1 On the View menu, click Large Toolbar Icons .

Customize capsule reports

Change the capsule report layout
1 On the View menu, pointto Layout, and then click the layout that you want to use.

P
4

I@ More information

1 Manager View Help u 0Customize Manager Viewo
1 Manager View Help u dThe Manager View windowo

Customize Manager View 1 7



Basic settings

FAQ: About basic settings

Frequently asked questions

This topic provides answers to some of the questions most frequently

asked about setting up and man

aging a Microsoft Dynamics POS store

What is the best order for entering store
information?

Certain records in Microsoft Dynamics POS will
not be complete until the records they depend
upon have been created. You can save yourself a
lot of data entry time by creating prerequisite
records first.

PN
4

|

L

More information

See 0Checkli st
set upochapter.t hi s

How do | set up devices on my registers?

The "Setting Up POS Hardware" tutorial walks
you through connecting various devices and
making them work with Microsoft Dynamics POS.

More information

In Manager View Help, see
oLearn to use |
Dynamics POS6
devices on a registero

| have store information in another program
or file. How do | get that information into
Microsoft Dynamics POS?

You can import data into Dynamics POS by using
the Import Wizard .

More information

In Manager View Help, see
OAbout i mporti.|
into the store

How do | customize the Manager View
window?

You can customize Manager View by choosing
your own capsule reports and changing their
layout, showing or hiding certain screen
elements, sizing the buttons on the toolbar, and
arranging columns and panes.

More information

In Manager View Help, see
0About izngManager
View. 6

FAQ: About basic settings
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Store settings

Payment methods

The types of payment that your store accepts

Payment methods  control and individually track the different types of
payments that come into the store. Customized to the needs of your
store, payment methods can also help you set and enforce store policies

In addition to a cash payment method, you might have payment methods for checks, gift
cards, debit cards, charge accounts, and one payment method for each credit card that you
accept (MasterCard, Visa, and so on).

The options that you set for your payment methods control how each type of payment is
handled by cashiers. For example, you can set the maximum amount that can be accepted
under a payment method, or you can choose to prompt cashiers to enter information about
customer checks.

Payment method formats
Each payment method you set up must be one of seven formats:

Account (charge accounts)

Cash

Check

Credit card

Debit card

Other

Voucher (gift cards, gift certificates, and store credit vouchers)

=2 =4 =4 4 -4 - -9

Tip

For credit and debit payment methods, set up validation formats (in the Advanced Options
dialog box) so that Microsoft Dynamics POS can make sure the number on a card matches the
numbering scheme used by the issuing company.

|@ More information

1 Manager View Help u @About payment methods 6
1 Manager View Help u 0GAbout store options 6



Store settings

Payment processing

Accept credit and debit cards and electronic checks

If your store accepts credit card, debit card, gift card, orcheck
payments, Microsoft Dynamics POS includes integrated payment
processing that you can easily set up to authorize and settle those
paymen ts.

Payment processing, sometimes referred to as electronic draft capture or EDC, includes boh
authorization at the time of purchase and settlement of transactions with the credit card
associations, transaction processors, and acquiring banks

While payment processing can be done using a standalone terminal (a small device that
connects with your payment processor or acquiring bank), you can save time by using the
payment processing features that are built into Microsoft Dynamics POS. Cashiers use
Microsoft Dynamics POS for every step of the transaction: adding items, accepting payment,
contacting the payment processor, and entering authorization codes. And when you are ready
to settle the day's card transactions, you can do that with a click of the mouse in Manager
View.

Microsoft has made arrangements with a number of preferred acquirers (acquiring banks) to
offer easy integration with the payment processing services offered by these acquirers. After
you choose a preferred acquirer, setting up payment processing involves these steps:

1 Createcredit and debit card payment methods

2 Set up any hardware you will be using, such as magnetic stripe readers, signature capture
devices, and PIN pads

3 Set up Microsoft Dynamics POS for payment processing

Once integration is in place, you can perform daily settlement of your credit and debit
transactions quickly and easily.

|@ More information

1 Manager View Help u 0GAbout payment processing6
1 Manager View Help u 0 A b gpayment methodsé



Store settings

Sales taxes

Flexibility to accommodate tax requirements

Microsoft Dynamics POS has been designed to accommodate the tax
requirements that your store is subject to, from simple percentage taxes
to complex compound taxes and partial dollar amounts

Sales taxes

Setting up sales taxes correctly for your store can save you time and money in several ways.
You can:

9 Easily control the accuracy and accounting of the taxes you collect.

71 Quickly change tax rates and authorities to comply with new laws.

1 Generate tax reports that can give you valuable insight and save time.

1 Make it easy for cashiers to modify transactions for varying tax requirements.

Setting up sales taxes

When you set up the sales taxes that are collected by your store,there are five things to
consider:

1 Choose your method of taxation

Choose between atax-exclusivesystem (typical in the United States and Canada) and a@ax-
inclusive system (such as VAT in Europe or GST in Australia).

2 Set up destination-based taxes and tax locations

If the taxes you collect for shipped goods vary depending on th e addresses you are shipping
to, you will need to set up destination -based taxes and tax locations.

3 Create tax authorities

Enter information about the tax authorities that asses s the taxes. For example, you might have
one tax authority representing the taxes assessed by the city where your store is located and
another representing the taxes assessed by the state or province.

Note

To change a sales tax rate, modify the taxauthority that assesses the tax

4 Create sales taxes

Once tax authorities are in place, you create the sales taxes that incorporate these tax
authorities. You will want one sales tax for every combination of tax authority taxes that must
be assessed.

For example, food items might incur a different combination of taxes than non -food items. In
that case, you might have a Food sales tax (containing the tax authorities that assess taxes on
food items) and a Non-food sales tax (containing the tax authorities that assess taxes on non
food items).

5 Assign sales taxes to items

You set the default sales tax that will be used for new items and their shipping charges when
you create new items, and then set the sales taxesfor the appropriate items in your store. You
can use the Inventory Wizard to change the sales tax that is assigned to a group of items.

Set up destination-based taxes
1 On the Settings menu, point to Store Settings , and then click Options .

2 Click the Sales Tax tab.



3 Under Tax calculations for  shipped items , select the Use destination - based taxes
check box.

4 In the Shipping Address Field column in the table, select the address fields that will
match the tax locations that you set up.

For example, if you collect taxes based on the county you ae shipping to, select County in
the first box. Select additional fields if other address fields should be compared to your tax
locations when there are no matches for the field in the first box.

5 To save your changes, clickOK.

Create a tax location
1 Onthe Settings menu, point to Store Settings , and then click Tax Locations .

2 On the toolbar, click New.

3 Enter a code and description for this tax location. The code should be a unique identifier or
abbreviation, such as "ALB" for Albany or "INST" for"in-state sale.”

4 Inthe Location type bhox, select the address field that this location corresponds to. For
example, if this tax location is for a county, select County.

Note

Only tax locations with types that match the address fields you selected when you set up
destination-based taxes will be used for tax calculations

5 For each place name that is included in this tax location, clickAdd, and then type the place
name in the new box in the list.

Tip

To improve the accuracy of tax calculations, createas many place names as you can think of for
each tax location. Be sure to add common (and not so common) abbreviations, misspellings,
and nicknames. Keep in mind that what the cashier types in the shipping address must exactly
match one of the place names listed here.

6 To save this tax location and begin entering information for another, click Save and New . If
this is the only tax authority that you want to create, click Save and Close .

Create a tax authority
1 Onthe Settings menu, pointto Store Settings , and then click Tax Authorities

2 On the toolbar, click New.

Create a sales tax

1 Onthe Settings menu, pointto Store Settings , and then click Sales Taxes.

2 On the toolbar, click New.

Set the default sales tax for new items
1 On the Settings menu, point to Store Settings , and then click Options .

2 Click the Sales Tax tab.

3 Inthe Sales tax on items box, select the sales tax that will be assigned to new items by
default. This will not affect items that already exist in the store database.

4 In the Sales tax on shipping charges  box, select the sales tax on any shipping charge for
an item. This setting will be applied to new items and will not affect items that already exist
in the store database.

5 To save your changes, clickOK.



Set the sales tax for an item

1 Onthe Inventory menu, click Items .
2 Double-click the item that you want to set the sales tax for.

3 Inthe Sales tax box, select the appropriate sales tax

l@ More information

Manager View Help u 0About taxesé

Manager View Help u dSet the method of taxation 6
Manager View Help u dSet up destination-based taxesd
Manager View Help u dCreate a tax locationd

Manager View Help u dCreate a tax authorityo
Manager View Help u dCreate a sales ta®

Manager View Help u 0Assign sales taxes to items)
Manager View Help u &Options - Sales Tax tald
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Store settings

Gift cards and other vouchers

Improve customer service and your cash flow

With Microsoft Dynamics POS |, customers can use vouchers  (such as gift
cards, gift certificates, and store credit vouchers ) as payment instead of
money, which has several benefits for your store

Benefits for your store

1 Increase sales and broadenyour customer base.

1 Improve customer service and encourage repeat business

1 Speed up your lanes by taking advantage of touchless transactions

1 Keep money in your store by issuing vouchers instead of cash refunds

Note

Before you can use vouchers at the raister, you must set them up in Manager View.

Gift cards

Use gift cards for customers to use themselves or give to others as gifts. You can issue and
accept gift cards using Microsoft Dynamics POS in two ways:

1 Service- managed gift cards - A third-party processing service manages your store's gift
cards. You first sign up with a gift card processing service that provides custom gift cards,
authorization, and tracks balances and payments. You then use Microsoft Dynamics POS to
sell and redeem the gift cards.

i Store- managed gift cards - Your store uses Microsoft Dynamics POS to track and
manage the cards, balances, purchases, and so on. You typically buy gift cards from a
vendor that provides custom gift cards with your store's name, logo, and other information.

Gift certificates

Customers can purchase gift certificates that they can give to others to use for purchases in
your store.

You use Microsoft Dynamics POS to sell and redeem the certificates. Microsoft Dynamics POS
also keeps trackof the balances and purchases.

Typically, your store would use another program, such as Microsoft Office Word, to design and
print gift certificates that include your store's name, address, and logo, and blank spaces where
the cashier can write in the amount, tracking number, date, and any other inform ation your
store might require.

Store credit vouchers

Use store credit vouchers to give store credit to customers for refunds or as change.
Typically, your store would use another program, such as Microsoft Office Word, to design and
print store credit vouchers that include your store's name, address, and logo, and blank spaces

where the cashier can write in the amount, tracking number, date, and any other information
your store might require.

Note

Store credit vouchers are different than customer charge accounts.

l[@ More information

1 Manager View Help u 0About gift cards, gift certificates, and store credit
voucherso




Store settings

Share information with Intuit.
QuickBooks.

Track each registerdés activity accur

You can easily share accounting information between Microsoft Dynamics
POS offers and Intuit ® QuickBooks ®.

Share information with Intuit QuickBooks

With QuickBooks, you chooseregular times to post your Microsoft Dynamics POS data to your
QuickBooks accounts

QuickBooks versions
Microsoft Dynamics POS can exchange information with QuickBooks 2007 or later

You set up information sharing with QuickBooks by starting the Accounting Integration Wizard.
In the wizard, you will retrieve your QuickBooks company file and chart of accounts, and then
assign the posting categories in Microsoft Dynamics POS to the appropriate accounts in your
QuickBooks chart of accounts. You can, if desirel, import QuickBooks information about items,
customers, or suppliers into the Microsoft Dynamics POS store database.

Once accounting integration is set up, QuickBooks commands will be added to the Settings
menu in Manager View. You can use those commandsto post closed Microsoft Dynamics POS
batches and item receipts to QuickBooks on whatever schedule works best for your store. You
can also periodically import QuickBooks information about items, customers, or suppliers into
the store database.

I@ More information
1 Manager View Help u @About sharing information with Intuit QuickBooksé
1 Manager View Help u dOptions - Payment Tak)




Store settings

Prompt for reasons for actions

Accurately control and track register activity

Microsoft Dynamics POS can prompt or require cashiers to select a
reason for specific types of actions, such as price change s, returns, or
discounts .

About reasons

Reason

A reasonin Microsoft Dynamics POS is an identifier that you can use to track and explain
various actions, such as why an item was returned or price changes made

To use reasons, first createthe reasons that your store needs. For example, you might have a
reason called "Defective" that cashiers can specify when a customer returns defective

merchandise. This can help you identify the item so you can take it out of inventory. You can
also include reasons on reports to help you track additional information and control inventory.

Then, dter you create a reason, specify that Microsoft Dynamics POS prompt or require
selecting a reason for specific types of actions, such as price changes, returns, discounts. You
can also specify start and end dates for a reason to be in effect.

To prevent problems in the store's transaction history, reasons cannot be deleted. If you no
longer want to use a particular reason, you can set the reason's end date, afte which, it will not
be displayed.

Create a reason
1 Onthe Settings menu, pointto Store Settings , and then click Reasons.
2 On the toolbar, click New.

3 Inthe Code box, enter a unique code (a number or abbreviation) for the reason. This code
will appear on line items in POS View.

4 In the Description box, enter a description.

For example, if you want cashiers to identify discounts given during an annual sale, you
could create a reason with the description "Annual Sale.”

5 Inthe Type box, select a type for the reason. When Microsoft Dynamics POS prompts or
requires a reason, reasons of the same type are displayed as choices.

For example, for the Annual Sale reason, you would select Discount for the type. Then,
when a cashier applies a discount and is pronpted for a reason, Microsoft Dynamics POS
displays the Annual Sale reason and any other reasons with the Discount type as choices
for the cashier to select from.

6 If you want to specify dates during which the reason is in effect, select the Start date and
End date check boxes and then specify the dates.

7 1f you want to allow an employee to enter a comment when the reason is selected, select
the Allow comment check box.

Specify when to prompt for or require a reason
1 On the Settings menu, point to Store Settings , and then click Options .

2 Click the Reasons tab.



3 For each action, select one of the following.
1 None - Microsoft Dynamics POS will neither prompt for nor require a reason.

9 Prompt for areason - Microsoft Dynamics POS will prompt for a reason. Selecting a
reason is optional.

1 Require areason - Microsoft Dynamics POS will require selecting a reason before the
action is completed.

Note

You should also create at least one reason for each action hat prompts for or requires a
reason.

For example, if you want to require a reason when cashiers apply preset discounts, you could
create reasons to identify them, such as "Annual Sale" or "Employee Discount.”

Stop using a reason
1 Onthe Settings menu, point to Store Settings, and then click Reasons

2 Double-click the reason that you no longer want to use.

3 Under Options , select the End date check box, and then select a date

|Q More information

1 Manager View Help u 0About reasonsé
1 Manager View Help u dOptions - Reasons tal®



Store settings

Offline mode

Keep your store operating when your network is down

With offline mode, you can continue to ring up sales and perform other
register tasks even if the connection to the store database is not available

About offline mode

First, set up offline mode for the store on the main computer with the store database. This
involves using the Offline Mode Wizard create the password for offline mode synchronization.

Second, set up offline mode on each register. This is also done using a wizard and involves
entering the synchronization password for the store, selecting the times when synchronization
with the main database should occur, and creating an offline database on each register.

Once offline mode is set up, it is available whenever the register is not able to communicate
with the main store database. Microsoft Dynamics POSdetects the lost connection and offers
the option of switching to offline mode.

You can also switch a register to offline mode manually, such as when you are preparing to do
maintenance on the database computer.

Microsoft Dynamics POS also detects when the connection to the main store database
becomes available again and offers the option of switching back to the main database. The
registerdés activity while in offline mode
completion of this synchronizati on, a report appears that details these changes and the results
of the synchronization.

You can also switch a register out of offline mode manually, such as when maintenance on the
database computer is complete.

Note

wi t h

To ensure the security of the store database, the store owner or manager should set up offline
mode and keep the offline mode password in a safe place.

l@) More information

1 Manager ViewHelpu 0 About offline modebé

b



Store settings

Currencies and exchange rates

Extend payment flexibility for your store and your customers

Currencies in Microsoft Dynamics POS represent the different forms of
currency that you accept. A cashier can select a different currency and
instantly see transaction amounts adjusted using the exchange rate you

specify .

About currencies and exchange rates

When you define currencies in Microsoft Dynamics POS, you set up the currencies that your
store will accept. If you will accept currency from another country, such as a store in the United
States accepting Canadian currency, the exchange rate will be stored with the currency you
create for this purpose.

Every computer using Windows has a default currency set in Control Panel. To ensure accurate
accounting, Microsoft recommends that all registers in the store use the same default currency.
The exchange rates for your other currencies will becalculated against this default currency.

Once you have currencies defined, you can assign them to payment methods. In effect, doing
this enables the exchange rate for the currency, since amounts due are adjusted automatically
when a cashier selects gpayment method that uses the currency.

You can also assign arrencies to suppliers, enabling exchange rates inpurchase orders and
inventory transfers.

|© More information
1 Manager View Help u @About currencies and exchange rates
1 Manager View Help u 0 Bout payment methodso6




Store settings

FAQ: Store settings

Frequently asked questions

Here are answers to some of the most frequently asked

specifying store settings

guestions about

How do | set up payment processing so the
store can accept credit, debit, and gift cards?

Setting up payment processing involves signing
up with a payment processor, creating payment
methods for the types of payments your store will
accept, and configuring payment processing for
those payment methods.

More information
In Manager View Help, see

0OAbout payment
and OAbout pay!

processing. o0

How do | control cashier workflow?

You can use a variety of methods to control what
cashiers can do, must do, and cannot da

More information
In Manager View Help, see
these topics:

T 0About empl

T oContr ol t h
wor ko

T oAbout task

0)
e

Do | set up one tax authority for each
governing agency that assesses a sales tax?

Some governing bodies assess different tax rates
on different types of goods. For example, a state
might assess an additional tax against liquor or
cigarettes. If a single agency assesses more than
one tax rate, you will need to set up a tax authority
for each rate.

More information

S e dAboatt a x e Managern

View Help.

If there is a network problem, can | still ring
up sales?
The registers in the store can switch to offline

mode and continue to perform many (but not all)
transactions and register operations.

More information
Se e Offine mode, 6in this
chapter.

FAQ: Store settings
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Customers

Track customer information

Use customer information to increase sales and improve service

Microsoft Dynamics POS offers several ways to record and track

customer information and many features that you can use to improve
customer satisfaction, market more effectively, and build relationships
with customers

Create and track basic customer information and purchase history.

Track custom information such as birthdays, club memberships, and so on.

Set discounts and price levels for specific customers.

Set up charge accounts for customers with flexible accounts receivable options.
Generate reports on customer activity.

= =4 =4 -4 -8 A

If your store is part of a chain of networked stores that use Microsoft Dynamics POS,
customers can be either global customers or local customers. A global customer is available
to all stores in the chain, while a local customers is awilable only to the store where the
customer account was created.

Create a customer
1 Onthe People menu, click Customers .

2 On the toolbar, click New.

3 Enter a unique customer number for this customer, or use the customer number supplied
by Microsoft Dynamics POS.

4 Enter a first name, last name, or both.
5 Enter other information about this customer.

6 To save this customer and begin entering information for another, click Save and New . If
this is the only customer that you want to create, click Save and Close .

Tip

I f you have an existing customer |ist, you
Wi zard. 6

View a customer's purchase history
1 oOn the People menu, click Customers .

2 Double-click the customer that you want to view .

3 Click the Purchase History tab.

Track custom information about a customer

Microsoft Dynamics POS provides 15 fields (boxes) where you can type custom information
about a customer. These fields are located on the Additional Information tab in the customer
window:

9 Fivetext fields for names, color preferences, or loyaltyprogram membership information.
9 Five numeric fields for sizes or the number of children the customer has.

9 Five date fieldsfor birthdays, anniversaries, or expiration dates.

First set up these fields bygiving them names, and then use them to record whatever
information is useful to you.

an



Set a discount for a specific customer
1 Onthe People menu, click Customers .

2 Double-click the customer that you want to modify .

4 In the Discount box, type the discount percentage that you want this customer to have.
For example, to give the customer a 10% discount, type 1Q

Note

Once a discount has been set for a customer, each item sold to that customer will
automatically ring up at its discount ed price.

Assign a customer to a price level
1 Onthe People menu, click Customers .
2 Double-click the customer that you want to modify .

4 In the Price level box, select the price level that you want to apply to this customer .

Set up charge accounts

You can create charge accounts for individual customers, set credit limits, and receive
payments to the account.

Microsoft Dynamics POS makes it easy to handle accounts receivable, interest charges, and
billing in any of several ways:

9 Through Microsoft Dynamics POS
1 By sharing information with Intuit® QuickBooks®
1 Through your store's existing manual procedures

Generate the Customer List report
1 Onthe Reports menu, point to Customer , and then click Customer List .

2 Make selections in the report window to specify the customer information that you want to
view.

@ More information

Manager View Help u 0About customerso6
'ﬂ Manager View Helpu 0 About setting up your

1 Manager View Help u dAbout importing information into the store
databaseo
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Customers

Contact customers

Market more effectively and build customer relationships

Acquire new customers and build loyalty . Target customer preferences
and create customer mailings based on buying preferences and purchase
histories . Provide customers with gift shipping and other delivery options

Send an e-mail message to a customer
On the People menu, click Customers .

Double-click the customer that you want to contact .
If you haven't already, type the customer's e-mail address in the E- mail box.

Click the Email button .

a b~ W N B

Compose and send your e-mail message as you normally would

Look up a customer's phone number
1 oOn the People menu, click Customers .
2 Sort or scroll through the list of customers until you find the one that you want .

3 View the customer's phone number in the Phone column.

Manage a customer's shipping addresses

In Microsoft Dynamics POS, you can store one or more shipping addresses for each customer.
This makes it easy for you to offer gift shipping and other delivery alternatives to your
customers.

1 oOn the People menu, click Customers .

2 Double-click the customer whose shipping addresses you want to manage
3 Click the Shipping Addresses tab.

4 Take one or more of the following actions :

Create a shipping address
9 Click New, and then fill in the new shipping address.

Copy the customer's main address
9 Click New, click Use Customer Address , and then make any desired changes.

For example, you can ship items to another resident of the customer's house, such as a
spouse, child, or roommate, simply by changing the name in the shipping address.

Modify an existing shipping address

9 Selectthe shipping address that you want to change, click Edit, and then make your
changes.

Set a shipping address as the primary shipping address

9 Select the shipping address that you want to make primary, and then click Set As Primary .

Delete a shipping address
1 Select the shipping address that you want to delete, and then click Delete .



Print address labels

1
2

On the Tools menu, click Print Labels , and then click the Address Labels tab.

In the Choose who to print labels for ~ box, select Customers or Suppliers , as
appropriate .

Click Filter .

In the Find dialog box, perform a basic or advanced search to locate customers or suppliers
meeting likely criteria, select the customers or suppliers you want to print address labels
for, and then click Select.

The seleced customers or suppliers will be added to the print list. To add more customers
or suppliers to the print list, perform additional searches as needed.

When the print list is complete, close the Find dialog box.
For more help with the Find dialog box, click Help on the Help menu there (or press F1).

Review the list of customer or supplier labels that will be printed. If you want to remove a
customer or supplier from the print list, select it, and then click Remove.

Under Label format , select the label format. If you are using a label printer, be sure to
select a compatible label format.

Under Number of labels per item , select the number of labels that you want to print for
each item, and then click Print .

To preview the labels you will be printing, click Print Preview .

@ More information

1 Manager View Help u 0About customersé
1 Manager View Help u dPrint address label



Customers

Charge accounts

Create charge accounts for valued customers

Setting up charge accounts for certain customers can increase sales,
improve customer service , and build relationships with customers

Charge accounts

You can create charge acounts for individual customers, set credit limits, and receive
payments to the account.

Microsoft Dynamics POS makes it easy to handle accounts receivable, interest charges, and
billing in any of several ways:

1 In Microsoft Dynamics POS through an Accounts Receivable addin program available
from Microsoft Certified Partners.

1 By sharing information with Intuit® QuickBooks®.
1 Through your store's existing manual procedures.

Set up Charge accounts
There are two steps to setting up a charge account for a customer.

1 First, you specify accourt information for the customer.

1 Then, you set up a charge account payment method for cashiers to use when they total a
transaction.

Specify account information
1 Onthe People menu, click Customers .

2 Double-click the customer you want to set up a charge account for.
3 Onthe General tab, under Account , select the Allow purchases on account  check box.
4

In the Credit limit box, enter the maximum amount you want the customer to be able to
charge.

5 Click Save and Close .

Set up a charge account payment method
1 Onthe Settings menu, pointto Store Settings , and then click Payment Methods .

2 On the toolbar, click New.

3 Enter a unique code and description, such as "CA" and "Charge account

4 Inthe Format box, selectAccount .

5 Set the quick key, maximum amount, and other options as you want them. For more
information, click the Help button on the toolbar of the Payment Method window.

6 Click Advanced .

7 Inthe Advanced Options dialog box, do the fo llowing :

1 Select the Prevent overtendering check box if you will only accept the exact amount
due for this payment method.

1 Inthe Terms and conditions box, enter any terms and conditions of the account that
you want to print on receipts when this payment me thod is used.

1 Click OK to save the advanced options



8 Save the payment method. If you do not save, the advanced options you set will be lost.

9 Run a Z report on each register.

P

l@ More information
1 Manager View Help u @About charge accountsd
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FAQ: Customers

Frequently asked questions

This topic provides answers to some of the questions most frequently
asked about tracking customersin Microsoft Dynamics POS

How can | keep customer numbers from being
confused with item numbers?

You can set up Microsoft Dynamics POS to

automatically assign customers an easily recognizable

custom number format.

\

More information
Se eUseéautomatic
customer numbering 6
in Manager View Help.

Why are there gaps in my customer numbering?

When you create a new customer, the customer
number that is automatically filled in for you will not
be used again, even if you close the customer record
without saving. For this reason, you might see gaps in
your customer numbering .

P
’
I@
\

More information
S e dJse@utomatic
customer numbering 6
in Manager View Help.

What happens to the purchase history for a
deleted customer?

Deleting a customer deletes the purchase history for
that customer. This information cannot be recovered
once it has been deleted.

The transactions involving a deleted customer will still
exist, but they will no longer be associated with the
customer.

More information

S e Deldie a
customer6 i n Ma
View Help.

FAQ: Customers 3 9
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Employees

About employees

Let Microsoft Dynamics POS help you manage your employees

Managing retail employees brings many rewards and challenges. Microsoft
Dynamics POS can help you manage your employees, accurately and

efficiently, while helping to ensure the security of your store 0s
information

Manage employees

Microsoft Dynamics POScan help you mange employees in several important ways. You can:
I Store basic information about each employee.

Generate reports on your employees' register activity.

Record the hours each employee works.

= =4 =

Manage the security of your stored mformation by regulating employee access with
employee roles.

Set options that control employee workflow.
Customize POS View for each employee.
Specify sales reps and commissions.

= =4 =

Tip

You can generate reports to track employee performance, activity, and hours worked. These

include the Daily Sales by Employee, Top Performer by Employee, Cashier Log, and Time Clock
reports. For details, see OMore information, 6 opposite

Manage employee information

Create or view employee information
1 oOn the People menu, click Employees .

2 On the toolbar, click New, and then enter Windows Administrator credentials if prompted.
3 Under Contact information , type the employee's name and contact information.
4

Under Role and task pad , select the employee's role and the task pad that the employee
will see first in POS View.

5 Under Logon information , type a unique Employee ID , and then type the Password and
Confirm password for the employee.

6 Under System administration , select the check boxes for the tasks that this employee is
allowed to perform, and clear the check boxes for the tasks that this employee is not
allowed to perform.

7 To save this employee, clickOK.
Create or change an employee6 D or password

Note

You can also change an employeeds password

1 oOn the People menu, click Employees .
2 Double-click the employee that you want to modify .

3 ClickManage, and then enter Windows Administrator credentials if prompted .

on

t



4 To change the employee’s ID, type the new ID in the Employee ID box.

To change the employee's password, clickPassword, type the password in both the
Password and Confirm password boxes, and then click OK.

Note

For tasks involving an employee's user accountd such as when you create a new employee
make ID, password, or role changes for an existing employeed you will need to provide
Windows Administrator credentials for the computer where you are performing the task .

or

1 If you are using Windows Vista and you are not logged on as an Administrator, you will be

prompted for Administrator credentials.

1 If you are using Windows XP and you are not logged on as an Administrator, you will need

to restart Microsoft Dynamics POS. For

more inf

POS as an Administratoré in Manager View Help.

If you are performing these tasks from an additional (register) computer in the store, special
considerations come into effect.

For more information, see GAbout system administration from a register computer 6 i n
View Help

Manager

l@ More information

1 Manager View Help u AAbout employeeso
1 ManagerViewHelpu 0 About reportso
1 Manager View Help u 0About the time clock 6



Employees

Use the time clock

Record the hours worked by each employee

Employees clock in and out in POS View, and then you can view, edit,
and create reports about their work hours in Manager View

Use the time clock

The daily work hours for each employee are saved as eparate time clock entries. The entries
are listed together in Manager View, so you have a fast and easy way to monitor employee
time. You can also generate the Time Clock report

View time clock entries
1 oOn the People menu, click Time Clock .

2 Do one of the following :

1 To view entries for a specific role, dick the header of the Role column, and then scroll to
the role you want.

9 To view entries for a specific employee, dick the header of the First Name or Last
Name column, and then scroll to the employee you want.

1 To view entries for a specific day, dick the header of the Time In or Time Out column,
and then scroll to the day you want.

1 To create a new time clock entry, on the toolbar, click New.

1 To modify an existing time clock entry, double-click the time clock entry that you want to
modify .

i To delete a time clock entry, select the time clock entry that you want to delete, and then
click Delete .

Generate the Time Clock report
1 On the Reports menu, point to Miscellaneous , and then click Time Clock .

2 Make selections in the report window to specify the time clock information that you want
to view.

|@ More information

1 Manager View Help u @About the time clock 6



Employees

Control cashier work flow

Ensure that your register work flow is easy and efficient

With t he store options in Microsoft Dynamics POS , you can be very
specific about what  cashiers can do, cannot do, and must do , especially
when combined with the controls that you specify by carefully assigning

your employees to roles

Cashier work flow options
You can specify settings that:

Prompt cashiers to add a customer on each transaction.

Display a message when an outof-stock item is added to a transaction.

Prevent the sale of items that are out of stock.

Require cashiers to log on before each transaction.

Require opening and closing amounts to be entered before a batch can be closed.
Prompt cashiers for transaction details on each transaction.

Automatically start the next transaction when the cash drawer is closed.

=A =4 =4 -8 -4 -4 —a -9

Prompt cashiers to select a reason for certain actions, such as discounts or returns.

Set options to control the way cashiers work
1 On the Settings menu, point to Store Settings , and then click Options .

2 On the POStab, click Workflow .
3 Select or clear the options that are appropriate for your store .
4

On the Reasons tab, specify None, Prompt for a reason , or Require a reason for each
type of action.

Control the way specific items are sold
1 Onthe Inventory menu, click ltems .

2 Double-click the item that you want to modify .
3 Click the Options tab.
4

Select or clear the options that are appropriate for the item.

|@ More information
1 Manager View Help u @GAbout store options 6
1 Manager View Help u 0About itemso
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Employees

Assign employee roles

Hel p secure your storeds i1 nformat

Employee roles can help you secure your store's information by restricting
access to certain features in Microsoft Dynamics POS. They can also help
you enforce store policies by preventing certain actions from being taken

Employee roles

Microsoft Dynamics POS includes three predefned employee roles: Manager, Supervisor, and
Cashier. Each role has settings that allow or deny access to features in Microsoft Dynamics POS.
You can change these settings to customize these predefined roles, or you can create your own
roles.

Denying access tocertain rights automatically denies associated accessFor example, if an
employee is not allowed to view customers, that employee will also not be allowed to modify
or delete customers.

Similarly, some role settings havean effect in more than one place in the program. For
example, an employee who cannot view item costs will not be able to view supplier prices for
the item, either.

Unless you customize the settings for a specific employee, all of the employees assigned to a
role have the same rights. For this reason, you might assign an employee to a role despite a
difference between the employee's actual job title and the name of the role.

For example, you might assign a trusted cashier to the Supervisor role to give the cashier
access to more features than you give to other cashiers, even though their job titles are the
same.

Conversely, you might assign an assistant manager to a Cashier or Supervisor role to prevent
access to Manager View or other Microsoft Dynamics POS features.

Tip

Assign a unique task pad to each role to give the employees assigned to the role quick access
to the register tasks they perform most.

Assign employee roles
There are two steps to assigning employee roles.

1 Review the settings of preset roles, and then change ther settings or create new roles, if
necessary

1 Assign each employee to a role.

Change a roleds settings
1 On the Store menu, point to Store Settings , and then click Roles.

2 Double-click the role that you want to modify .
3 Make changes in the Name and Description boxes, as desired
4

To select a different default task pad for the role, select the new task pad in the Default
task pad box.

5 To change which features can be accessed by the employees assigned to this role, select or
clear check boxes in the Customization settings for this role list.

To allow access to a feature, select the check box for that feature. To deny access, clear the
check box.



Create a new role
1 On the Store menu, pointto Store Settings , and then click Roles.

2 On the toolbar, click New.
3 Enter a name and description for the role.
4

In the Default task pad box, select the task pad that employees in this role should see
first.

5 To set the features that can be accessed by the employees assigned to this role, selet or
clear check boxes in the Customization settings for this role list. To allow access to a
feature, select the check box for that feature. To deny access, clear the check bax

6 To save this role and begin entering information for another, click Save and New . If this is
the only role that you want to create, click Save and Close .

Assign an employee to a role
1 oOn the People menu, click Employees .

2 Double-click the employee that you want to modify .
3 Inthe Role box, select the new role for this employee.

Assign a task pad to a role
1 Onthe Settings menu, pointto Store Settings , and then click Roles.

2 Double-click the role that you want to modify .
3 Inthe Default task pad box, select the task pad for this role.
Note

Changing the task pad setting for a role does not change the task pad assigned to an existing
employee in the role. The setting only applies to employees created from now on.

You can override this setting for a specific employee in the role.

|® More information

1 Manager View Help u @About roles and role settings6
1 Manager View Help u dAbout employeeso



Employees

Customize POS View for each
employee

POS View can work the way cashiers do

When you customize POS View for each employee, you can maximize
productivity while speeding operations at the register. Customizing POS
View can also accommodate employees with special accessibility needs.

Make POS View more accessible for a specific employee
1 On the People menu, click Employees , and then double-click the employee that you want.

2 Onthe Register tab, under Accessibility :

1 Select the font and button size, Normal or Large, that will best meet this employee's
needs.

1 Select the task pane alignment, Left or Right, that will best meet this employee's needs.

Note

You can further modify the display from within POS View.

Select a task pad for a specific employee
You can choose which task pad each employee sees firstvhen they log on to POS View.

1 On the People menu, click Employees, and then double-click the employee that you want.
2 Inthe Task pad box, select the task pad for this employee.

Change the task pane alignment for a specific employee

1 Onthe People menu, click Employees , and then double-click the employee that you want.

2 Under Accessibility , in the Task pane alignment box, select the alignment, Left or Right,
that will best meet this employee's needs.

'@ More information

1 Manager View Help u @About employeeso
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Employees

Manage sales reps and commissions

Designate an employee as a sales rep and specify commission rates

Commissions can be calculated as a fixed amount per item sold, a percent
of a line item's extended sales price, a percent of a line item's extended
profit, or a combination of the three

You can also specify an employee as a si@s rep without any commission, so that the sales rep
can simply be associated with transactions.

You can specify commission rates for individual items that override a sales rep's commission
schedule.

Cashiers specify sales reps when ringing up individualine items at the register. You can set up
Microsoft Dynamics POS to prompt cashiers to select a sales rep

Specify sales reps and commissions
1 Onthe People menu, click Employees , and then double-click the employee that you want.

2 Onthe Commission tab, select the Eligible for commission  check box, and then specify
a commission.

If you want cashiers to be able to simply associate sales reps with sales without earning a
commission, make sure the Fixed amount , Percent of sales , and Percent of profit boxes
all have zero amounts.

Specify commissions for individual items
1 Onthe Inventory menu, click ltems, and then double-click the item that you want.

2 Onthe Commission tab, under Commission basis , specify the commission that applies
to the item.

@® More information

1 Manager View Help u 0About sales reps and commissiong
1 Manager View Help u GAbout itemso
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Employees
FAQ: Employees
Frequently asked questions

Here are answers to some of the questions most frequently asked about
managing employee information in Microsoft Dynamics POS

Does an employeebs r
the employee?ds actue

No, you can create new roles with specialized / @ More information
settings to enable or restrict access to specific Se e About roles and role
features in Microsoft Dynamics POS You can settings6in Manager View Help.

also customize for each employee the roles
that are already included in Microsoft
Dynamics POS.

Why assign different task pads to different
employee roles?

You can create custom task pads to meet the @\ More information
specific needs of your employees. You might L S e dboottaskpads6 i n Ma
even decide to create a series of task pads that View Help.

define workflows for your cashiers, making
what they're supposed to do at the register
easier and less ambiguous.

Additionally, you can use different task pads
for different employees by assigning a unique
task pad to each employee role. You'll find that
task pads reduce keystrokes and speed up
transaction time by giving cashiers faster
access to the tasks they use most often

Some employees donot
register, so how do they clock in?

Time clock entries are usually created in POS @ More information
View when employees clock in and out on their S e éboat the time clocké 1 n
registers. But, you can also create time clock Manager View Help.

entries in Manager View if some employees,
such as stockers, don't have access to a
register.
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Inventory

About inventory
ltems

Departments and categories
Matrix items
Purchase orders
Discounts
Customer orders
Physical inventories
Inventory locations
Inventory transfers
FAQ: Inventory

51
52
53
54
55
56
58
59
60
61
62



Inventory

About inventory

Streamline and automate inventory management

Each thing for sale in your store is represented by an item record in
Microsoft Dynamics POS , making it easy to organize, track, sell, and
account for your inventory, whether you sell products or services.

Item records contain a lot of information, from the most basic inform ation & such as item
number and description & to detailed quantity and pricing information, to settings that
regulate how the item is ordered and sold .

If you want, you can group similar items (such as apparel items) into matrix items, or order and
sell items using different package sizes.

For easier management, organize items into departments and categories. Departments provide
the major divisions in your inventory, with categories dividing departments into smaller groups.
Using departments and categories can make it easier to order, monitor, and even sell your
stock.

Control the flow of stock into and out of your store by using purchase orders, item receipts,
and inventory transfers. These documents make ordering, receiving, and returning stock faster
and easier, with automatic quantity detection and adjustments, "primary supplier" selection,
and, if desired, price and cost changes. Handy wizards make creating purchase orders and
inventory transfers fast and easy.

Speed up inventory counts using physical inventory count sheets. With the click of a button,
you can compare counted quantities to expected quantities. You can also instantly update the
database quantities with the reconciled counted quantities.

Save hours of data entry time by importing inventory information into the store database. The
Import Wizard makes import operations quick and easy.

l@ More information

1 Manager View Help u &About managing your inventory 6
1 Manager View Help u @About receiving inventory 6



Inventory

ltems

Look up item information quickly and easily

Simply stated, an item is a product sold by your store. It refers to actual
physical items, of course, but it can also mean intangible products, such
as services offered by your store or handling fees that you charge

In addition to item and bar code numbers and descriptive information about the item, each
item record contains quantities (such as number in stock and number on order) and tax, cost,
price, discount, and supplier information. It also contains options and settings that regulate
how that particular item is sold and ordered.

Here are some of the things you can do with i tems:

Create, modify, and delete items, one or many at a time
Import existing inventory

Print item labels

Generate reports about items

Organize items into departments and categories
Organize similar items into matrix items

Create kit items

Assign specificsales taxes to items

Automatically reorder items

Create packaging units for ordering

Put items on sale

Discount specific items

Set multiple price levels for specific items

Specify substitutes for out-of-stock items
Manage serial numbered items

Create messaes to cashiers for items

Move items between inventory locations

Use price-embedded bar codes for weighed items

=2 =4 =4 =4 -4 A4 -4 A -—a —a A a8 a8 -a a8

Use noninventory items

|@ More information
1 Manager ViewHelpu 0 About i temso
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Departments and categories

Organize your inventory

Organizing your inventory into departments and categories can help you
manage inventory, help cashiers locate items at the register, and
streamline your  reporting

In a large store, the benefits of organizing inventory into departments and categories might
seem obvious. For example, a department store might have a Juniors department, with
categories within that department for Clothing, Accessories, Footwear, and Sleepwear.

Even small stores can take advantage of these benefits, though. For example, a wine shop
might create departments for wine groups, such as Reds and Whites, with categories for
varieties such as Cabernet and Riesling. Alternatively, the ower might prefer a department for
each wine-producing region, such as Washington, Italy, and France, with categories for specific
vineyards.

When creating your departments and categories, keep in mind that the Inventory Wizard and
other features in Microsoft Dynamics POS provide ways to automate tasks by department or
category. For example, you can organize report data by department and category so you can
track sales and other information for very specific groups of items.

Once items are organized in departments and categories, you can:

|Q More information
1 Manager View Help u 0About departments and categorieso
1 Manager View Help u dAAbout items6




Inventory

Matrix items

Power and convenience for managing related items

Especially useful for items like apparel, y Ou can group items into a matrix
by assigning the same style number to each item. If the individual items
do not exist in the database yet, you can quickly create the entire group

of items at once

A matrix is a group of related items, such as items that are sold in a variety of colors, sizes,
flavors, or models. For example, a Tshirt that comes in four sizes and three colors can be
represented by twelve items in one matrix, each item with its own quantities and other
properties.

In this case, the dimensionsin the matrix are Size and Color.Each dimension has attributes; for
example, Size might have atributes of Small, Medium, and Large. You can save dimensions
independently for use with other matrix items.

Matrix items can be managed as individual items, but you also have access to detailed
inventory information about the whole matrix.

You can creatematrix items from items already in your inventory or create new ones all at
once.

|Q More information

1 Manager View Help u 0About matrix items and style numberso
1 Manager View Help u @About lots 6
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Purchase orders

Flexibility for a variety of purchasing processes

You can continue your current process & perhaps replacing some manual
steps with Microsoft Dynamics POS automation d oryou can start from
scratch, taking full advantage of the features in Microsoft Dynamics POS

to streamline your ordering

Microsoft Dynamics POS can accommodate a variety of purchase ordering processes.

For example, some managers might prefer to do all of their ordering over the Internet or by
phone, only entering purchase order information into Microsoft Dynamics POS when a
shipment is received.

Others might want to manage every aspect of ordering i from creating the purchase order to
printing labels for the items received fi from within Microsoft Dynamic s POS.

Microsoft Dynamics POS easily accommodates either of these approaches, or something in
between.

Basic purchase order process

1 First, create a purchase order, either manually or by using the Purchase Order Wizard.
With the wizard, you can create purchase orders automatically, based on stock levels or
sales.

1 Second, mark the purchase order as placed and send it to the supplier. You can email the
purchase order from Microsoft Dynamics POS or print it and either fax or mail it.

1 Third, when the shipment comes in, receive the items using an item receipt, either at the
register or in the back office, in Manager View or POS View.

Powerful features such as item scanning and orthe-fly addition and pricing of ordered or
received items give you maximum efficiency.

Additional purchasing features

Mi crosoft Dynamics POS includes many more featur
purchasing. Some of these are listed below.For detail s, see OMore inforn
Generate the Purchase Ordes report.

View the history of a purchase order.

Specify reorder and restock settings for ordering.
Specify the primary supplier for items.

Specify supplier-specific reorder information

Apply a formula to the information in a purchase order
Specify different delivery addresses

Send a purchase order in an e mail message

Print a purchase order

Export a purchase order to a file or to another program
Receive partial shipments against a purchase order
Print labels for items in a purchase order
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Prevent items from being added to purchase orders

l@ More information

1 Manager View Help u 0About purchase orderso
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Discounts

Many ways to offer discounts to your customers

Microsoft Dynamics POS includes several d
hat you can assign to each item.

variety of prices t

iscounts in addition to a
You can design a

pricing and discount scheme for your store that is as simple or as

sophisticated as you need it to be

Customer discount

Examples

Automatically discount all
transactions for a specific customer.

1

A certain contractor is a home
improvement store's best customer. The
store owner sets a 15% customer discount
that is applied automatically to all of the
contractor's transactions.

1 To encourage a dissatisfied customer to
come back another time, a florist sets a
10% discount for the customer.
Item discount (Mix and
Match, unit pricing, and Buy
X, GetY) Examples
Discount an item automatically when 1 A store owner wants to offer a Buy 2, Get
it is added to a transaction that meets 1 Free special on certain candy bars.
the conditions of the discount . f To reduce overstock, a store owner offers
unit pricing on several styles of glassware.
1 A bookstore offers a 20% discount to
customers who purchase more than four
paperbacks in a single transaction.
Quantity discount pricing
schedule Example
As with a Mix and Match item I Toencourage sales, a store owner sets up
discount, discount a single item when a quantity discount pricing schedule for a
purchased in quantity. discontinued item.
Preset discount Examples
Make a discount available to cashiers  f A store owner sets up a 30% preset
when a certain item is added to a discount for damaged merchandise and
transaction. makes it available for all items in the store.
1 Every Tuesday, the cashiers in a wine shop
apply a preset discount that sells local
wines at 10% over cost.
Transaction discount Example
Manually apply a discount to a 9 Faced with an angry customer, a

transaction in progress.

supervisor applies a 10% discount to the
customer's current transaction.

Discounts
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Line item discount

Example

Manually apply a discount to a line
item in a transaction in progress.

Price level

1 An antiques dealer convinces a customer
to buy two pieces by discounting the price
of one piece.

Example

Provide varying prices for an item.

Price adjustment

1 The owner of a crafts shop sets up price
levels for her walk-in, Internet, and
business customers

Example

Manually change the price of a line
item in a transaction in progress.

Sale price

I To avoid being undersold, an electronics
store manager types a one-time lower
price for a television into the transaction
pane.

Example

Put a specific item on sale for a set
period of time .

-
y/

I@ More information

1 A department store owner preparing for a
Labor Day sale uses the Inventory Wizard
to set sale prices for all items in the House
wares department.

1 Manager View Help u @About discountsé
1 Manager View Help u 0About itemso
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Customer orders

Order merchandise or services for your customers

In Microsoft Dynamics POS, you can create several kinds of orders  when,
for example, something is out - of- stock, a customer needs work done, or
wants to put something on layaway . Orders can both increase sales and

improve customer service.

You create these orders for customers in POS View

In Manager View, you can specify various settingsfor the new orders that you create; for
example, a layaway's next payment date or the minimum deposit for special orders.

Back order

When an item is out of stock, you can create a back order for a particular customer. This order
is added and tracked with your regular purchase order schedule.

Layaway
A customer makes payments for a sale and the store holds the item until payment is complete.

Quote
Also called an estimate, use a quote to estimate the price of particular goods and services

Special order

When you create a special order for a customer, it creates an immediate purchase order for the
desired item. This can be useful either when the customer wants the item quickly or the item is
not something you normally carry.

Work order

The primary transaction type for service-based retailers for work performed.

l@ More information

1 Manager View Help u dAbout customer orderso
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Physical inventories

Quickly know what stock you have and where it is

In Microsoft Dynamics POS, fiphysical inventory 0 refers to a list of the
items that you planto count , as well as the process of performing an
inventory count of what items you actually have inyo  ur store .

A physical inventory, sometimes called a count sheet, can be printed or exported to another
program for use during a physical inventory count. After the count is complete, you can return

to Manager View and use this list to enter the counted quan tities, calculate any discrepancies,

and update the in-stock quantities in your store database.

Perform regular counts of the actual inventory in your store to monitor shrinkage, the
difference between the recorded value of your inventory and the retail va lue of the actual
inventory of the store. You have shrinkage when your recorded item counts are less than your
actual item counts.

With the automation it provides, Microsoft Dynamics POS can help you perform these counts
more frequently so that you are able to respond to shrinkage problems as they occur.

|@ More information

1 Manager ViewHelpu 0 About physical inventor.i

1 Manager View Help u dtemsé
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Inventory locations

Accurate and flexible inventory tracking

An inventory location can be an actual physical location (such as Back
Room, Warehouse, or Under the Stairs), or it can be a conceptual
grouping of items (such as Damaged, Reserved, or Not Yet Shelved) .

The quantities of an item that are in an inventory location are not available for sale.

For example, a sporting goods store might have 12 footballs in stock, but with 1 in the
Damaged inventory location and 3 in the Not Yet Shelved inventory location, only 8 will show
as available.

If you want, the quantities of an item that are in an inventory location can be factored into the
reordering calculations made by the Purchase Order Wizard.

For example, you could have items that are in the Not Yet Shelved locdion counted so that
reordering doesn't happen too soon, while having the items that are in the Damaged location
ignored by the Purchase Order Wizard so that they'll be replaced promptly.

You can move item quantities into and out of inventory locations in the following ways:

From available to an inventory location

From an inventory location to available

From one inventory location to another

From an inventory location to an inventory transfer out
From a return transaction to an inventory location

You can ako make a manual adjustment to the quantity in any inventory location. Keep in
mind, though, that this will affect your total inventory quantity, since there won't be a
balancing quantity change in another location.
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l@) More information
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Inventory transfers

Move inventory into and out of your store

Use inventory transfers to track inventory thatyou move into and out of
your store without processing sales or purchase orders

Inventory transfers are most commonly done when transferring inventory from one store to
another, but you might also use inventory transfers to return stock to a supplier, to move stock
into the store from storage or a warehouse, or to move seasonal or damaged stock out of the
store.

You can create inventory transfers manually or with the Inventory Transfer Wizard.

The inventory transfer window has two modes; Edit and Issue/ReceiveThe available toolbar
buttons, menu commands, and summary fields (statistics) will vary dependng on which mode
you're in.

Additional transfer features

Microsoft Dynamics POS includes many mae features that can speed and improve your
transfers.

Generate an Inventory Transfers report.

View the history of a purchase order.

Apply a formula to the information in a transfer

Specify different addressesin a transfer

Send an inventory transfer in an e-mail message

Print a an inventory transfer

Export an inventory transfer to a file or to another program
Receive partial inventory transfers
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Print labels for items in an inventory transfer

'Q More information

1 Manager View Help u 0About inventory transferso
1 Manager View Help u @About reports 6
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FAQ: Inventory

Frequently asked questions

This topic provides  answers to some of the questions most frequently
asked about managin g inventory in  Microsoft Dynamics POS

What different kinds of items can | have in
Microsoft Dynamics POS?

Standard items are tracked in inventory and are l/"_\ More information
usually assigned a department and category to assistin See 0o Aibtoaurhs 6
analyzing productivity and profits . Manager View Help.

Serial numbered items are inventory items that have
one or more serial numbers assigned, such as bicycles

Noninventory items, such as shipping charges or gift
wrapping charges, are not tracked in inventory.

Are there any special requirements for item

numbers?

A unique item number and description, eachupto 35 @ More information
characters long, is required for each item. If your store See O0OAbout
uses a scanner, make sure your item numbers are at Manager View Help.

least 3 characters long, orthey will not scan properly .

Can | delete items when the store no longer
carries them?

Deleting items can adversely affectpast transactions (" B More information

and accounting information.1 t 8s better t S e Maké an item

items inactive when you no longer carry them. inactive6  NMamager
View Help.

FAQ: Inventory 6 2



Registers

About registers
Customize registers
Manage POS hardware
Manage receipts

FAQ: Registers

64
65
66
67
68



Registers

About registers

The points of sale in your store

Any computer in the store that has Microsoft Dynamics POS installed can

be a Aregi st er . 0 stéromighthava aregister,for each of

four lanes, a register in the back office for mail orders, and the main
computer in the back office for manageri alwork 7 a total of six registers.

The first register in your store, Register 1, is created automatically when you start Microsoft
Dynamics POS for the first time. Register 1 is usually your store's main computer and the
location of the store database. Itis considered a register even though it might not be used to
process transactions.

In Microsoft Dynamics POS, the wordregister refers not only to the lane and computer
equipment in your store, but also to the database records that contain the settings fo r the
register.

These settings include the register number and description, the hardware devices in use at the
register, and any receipt formats and line display messages being used by those devices.

See the topics on the fol mawioag, pabebowndf on wiyp
registers productive and easy to use; for example,

Customize registers

Manage POS hardware

Manage receipts

Assign a task pad to a register

Use a line display message at a register
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l@ More information
1 Manager View Help u 0About registersé
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Customize registers

Set up your registers to work the way you do

You can customize your Microsoft Dynamics POS registers in a variety of
ways that can make them more productive and easier to use.

See OMore information, 6 below, for details about
registers for your store and your cashiers.

Customize the register function keys

Use sounds at the register

Change the payment method display order

Change the POS View task pane alignment for a specific employee
Make POS View more accessible for a specific employee

About task pads

Assign a task pad to a role

About the currency calculator

About touchless transactions

About registers
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About devices on a register

|Q More information

1 Manager View Help u AAbout customizing your registers 6
1 Manager View Helpu 0 A b dask padso
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Manage POS hardware

Change device settings for any register from the main computer

Once a device is installed and available on a register in your store, you
can change its settings  in Manager View from the main computer or any
other register

Change a registerd6s device sett.i
1 On the Settings menu, point to Register Settings , and then click View/Edit Registers .

2 Double-click the register where the new device is located.

3 Inthe Available devices list, select the new device, and then click the right-arrow button
to add the device to the Selected devices list.

4 If desired, click Properties , and then change the settings for this device. For help setting
device properties, click Help in the Device Properties dialog box.

Note

If a register's device does not appear in the Available devices list, you need to start Microsoft
Dynamics POS on the register andinstall and set up the device there.

After that, you'll be able to change the device® settings from the main computer or any
register.

l@ More information
1 Manager View Help u @GAbout devices on a registerd
1 Microsoft Dynamics POS 2009 CDu Tutorial: 6Setting Up POS Hardwared

Manage POS hardware 66
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Manage receipts

Use preset receipts or create your own

Microsoft Dynamics POS comes with two receipt formats that you can
use out - of - the - box; a 40 - column format for receipt printers and a full -
page format for regular printers.

When you install and set up a printer for a register, you tell Microsoft Dynami cs POS which
format to use.

You can modify the preset formats or create your own and then assign them to the printers
that your registers use.

Each receipt format can contain severaldifferent receipt templates. These templates provide
the layout, content, and formatting for the following types of documents:

Receipts for sales transactions

Receipts for cancelled transactions

Receipts for cash drops

Receipts for cash payouts

1 X, Z, and ZZ reports

You can modify an existing receipt format either by selecting different templates for each of
the document types or by changing attribute values .
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You can save electronic copies of your store's receipts and X, Z, and ZZ reports in your store
database. You can then view or reprint those receipts or view detailed paymert information for
a transaction.

l@ More information

1 Manager View Help u dGAbout receipt formats 6
1 Manager View Help u dTurn on receipt journaling 6
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FAQ: Reqisters

Frequently asked questions

Here are answers to some of the most frequently asked questions about

managing registers in Microsoft Dynamics POS

When setting up additional registers, do | need
to create each one from scratch?

You canduplicate an existing register. Any device |@
assignments will be copied over, as well asany :
device properties, such as receipt journaling. Youcan

modify these settings after the register is duplicated .

More information

Se eDuplicate a registeroin
Manager View Help.

Why dondt delice that ewant to enake
available to a register in the Available devices

list? B
If the register's devices do not appear in the |@
Available devices list, you need tostart Microsoft L
Dynamics POSon the register and set up the devices

there. After that, you'll be able to manage the

devices from Manager View on any register.

More information
S e bodt registers6 i n
Manager View Help.

Why am | getting a beep for each event after
adding audio feedback with full sounds?

If no sound card is installed onther e gi st er & |O
computer, the system beep will be played instead of
full sounds.

More information

S e d&Jsedounds at the
register6 i n Manag
Help.
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About transactions and batches

Settle credit and debit card transactions
Manage transactions and batches

FAQ: Transactions and batches
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